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1. About Kernel for Exchange Server 

1.1 Brief About this User Guide 

Welcome to the user manual of Kernel for Exchange Server version 9.09.01 - an advance, 
professional, and enterprise level Exchange database repair and recovery software. This user 
manual has been developed to provide you step-by-step guidance for using Kernel for Exchange 
Server software. Therefore, we suggest you to carefully read this user manual before you start 
using the software. The user manual comprises the following sections: 

Introduction: Provides brief information about the Kernel for Exchange Server software, its 
benefits, and key features. Moreover, the system requirements are also listed in this section for the 
successful installation and execution of the software. 

Install and Uninstall: Lists the processes to install and uninstall Kernel for Exchange Server 
software. 

Understanding the User Interface: Explores the user interface of Kernel for Exchange Server 
software for its easy and perfect use. In this section, you acknowledge accessing various menus 
and sub-menus for performing various Exchange database repair and recovery related tasks. 

Using Kernel for Exchange Server: Explains various recovery modes, using which you can 
efficiently repair damaged Exchange database file. Moreover, you acknowledge configuring 
software settings for fast and more effective result. 

Download Purchase and Register: Provides information about downloading, purchasing, and 
registering Kernel for Exchange Server software. Moreover, information related to technical 
support is also provided in this section. 

Legal Notices: Provides information about copyright notices, trademarks, disclaimer, and license 
agreement related to Kernel for Exchange Server software. 

1.2 Introducing Kernel for Exchange Server 

Microsoft Exchange Server, which is the most preferred email server from Microsoft Corporation, 
works in collaboration with MS Outlook. Emails, calendars, notes, journals, etc. you create using 
your MS Outlook account are stored in your mailbox on Exchange Server in .EDB and .STM files.  

Corruption in any of the .EDB or .STM files makes mailboxes on MS Outlook inaccessible due to 
which communication among Outlook users gets stopped. Apart from this, damage of the .EDB 
and .STM files can create big data loss for an organization. Moreover, projects can be delayed and 
business deals can also be affected due to stopped email communication. Therefore, the corrupt 
Exchange database files should be repaired as soon as possible.  

Kernel for Exchange Server helps you to recover user mailboxes from the corrupt Exchange Server 
database files and recover their emails and other items.  
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Kernel for Exchange Server software uses advance data recovery algorithms for accurate and fast 
mailbox recovery from damaged Exchange database files. With Kernel for Exchange Server, the 
user can find the suitable way to deal with Exchange dirty shutdown and attaining Exchange clean 
shutdown. Kernel for Exchange Server software impeccably repairs the Exchange database files 
that have become corrupt, damaged, or inaccessible due to one or more of the following reasons: 

¶ Exchange dirty shut down 

¶ Checksum errors 

¶ Exchange Server down time 

¶ Error in the physical storage media 

¶ Accidental deletion of mail boxes from Exchange Server 

¶ Corruption in fileôs header information 

¶ Accidental hard disk partition 

¶ Power outage 

¶ Page corruption in Exchange database file 

¶ Problem in initialization of Information Store 

¶ Accidental emailsô deletion from usersô mailboxes 

¶ Exchange Server error 550 

¶ Presence of duplicate keys 

¶ JET_errRecordNotFound error 

¶ Absence of required database key 

¶ Jet_errRecordDeleted error 

¶ Malicious virus infection 

¶ All types JET engine errors 

¶ File size error 

¶ Problem in database indexing 

¶ 614. All future database updates will be rejected. Information Store (3420) Unable to 
rollback operation #65678740 on database C:\EXCHSRVR\mdbdata\priv1.edb. 
JET_errKeyDuplicate Illegal duplicate key. JET_errReadVerifyFailure Read verification 
error 4294966 
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¶ # JET_errBadDbSignature -531 

¶ # JET_errDatabaseStreamingFileMismatch -540 

¶ # JET_errDatabaseDirtyShutdown -550 

¶ # JET_errConsitentTimeMismatch -551 

¶ # JET_errInvalidDatabaseId -1010 

¶ # JET_errInvalidDatabase -1028 

¶ # JET_errDatabaseSignInUse -1222 

¶ # JET_errDatabaseCorruptedNoRepair -1224 

¶ # JET_errFileInvalidType -1812 

1.3 Key Features 

Kernel for Exchange Server is unique and fast Exchange database repair and recovery software 
with following prominent features: 

¶ Effective and Fast: Performs fast and effective mailboxesô recovery from damaged and 
inaccessible Exchange database files. The software has powerful recovery engine using 
which it can even recover permanently deleted e-mails and mailboxes. Deleted emails are 
displayed in red color.  

¶ Complete Recovery: Recovers items from the damaged Exchange database file in fraction 
of minutes with full accuracy. The software is efficient to recover mailbox folders, calendars, 
appointments, journals, images, attachments, zipped attachments, notes, drafts, tasks, and 
junk e-mails.  

¶ Preserves Formatting: Maintains structure and formatting of the recovered e-mails and 
folders. Moreover, the software maintains the properties, such as To, Cc, Bcc, Time, and 
Date of the recovered mailbox items.  

¶ Advanced Setting Options: Facilitates you to configure various software settings for more 
result-oriented Exchange mailbox recovery. 

¶ Three Recovery Modes: Provides three recovery modes from which you can select the 
required one for exchange mailbox recovery and database rebuilding. Those recovery 
modes are - Automatic analyze and recover, Advance scan, and Rebuild corrupted 
database.  

¶ Save to PST: Saves mailboxes and email items recovered from damaged Exchange 
database file into .PST file format so that you can easily access them with MS Outlook. 

¶ Database Rebuilding: Rebuilds the damaged database and saves the rebuild database 
into .EDB format so that you can directly mount it on MS Exchange Server. After completing 
the database rebuilding process, software along with the .EDB file creates a Verify.bat file. 
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You can execute the Verify.bat file to ensure the successful recovery and database 
rebuilding on MS Exchange Server. 

¶ Hierarchical View: Displays the recovered mailboxes, e-mail folders, and other related 
items in hierarchical format for their easy view. Kernel for Exchange Server displays the 
content of the selected e-mail or other related item to let you verify the structure and 
formatting of the items recovered.  

¶ Save Information in HTML File: Saves the information about recovered email items of a 
mailbox in .html file. Information about the recovered email items is saved in tabular format; 
therefore, it becomes easy for you to gather details about a specific email item for a 
mailbox. 

¶ Advance Calendar View: Displays information related to calendar item in a mailbox into 
various calendar views. For example, you can view calendar entries in 31 days format, 7 
days format, 5 days format, or 1 day format.  

¶ Version Support: Supports MS Exchange Server 2007, 2003, 2000, 5.5, and 5.0 and MS 
Outlook 97, 98, 2000, 2003 and 2007.  

¶ Self Descriptive User Interface: Kernel for Exchange Server has interactive and self 
descriptive user interface, which require minimal technical skill to operate and manage.  

¶ Support: There is round the clock support for Kernel for Exchange Server provides, so that 
users may anytime contact with our technical team for troubleshooting the software related 

problems. Visit our Support Desk at http://www.nucleustechnologies.com/supportdesk/ 

http://www.nucleustechnologies.com/supportdesk/
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1.4 System Requirements 

Before you start installing Kernel for Exchange Server software on your computer, make sure that 
your computer system meets the following system requirements: 

System Requirements 

¶ Pentium Class Processor 

¶ 64 MB RAM (128 MB recommended) 

¶ 10 MB of free disk space for software installation 

¶ Enough disk space to store the recovered mailboxes 

Supported MS Exchange Server Version 

¶ MS Exchange Server 2007 

¶ MS Exchange Server 2003 

¶ MS Exchange Server 2000 

¶ MS Exchange Server 5.5 

¶ MS Exchange Server 5.0 

Supported MS Outlook Versions  

¶ MS Outlook 97 

¶ MS Outlook 98 

¶ MS Outlook 2000 

¶ MS Outlook 2003 

¶ MS Outlook 2007 

Supported Platforms 

¶ MS Windows 9X 

¶ MS Windows ME 

¶ MS Windows NT 

¶ MS Windows 2000 Server 
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¶ MS Windows XP 

¶ MS Windows Server 2003 

¶ MS Windows Server 2008 

¶ MS Vista 

@ MS Outlook must be installed on your computer system for successful 
working and use of the software. 

You must check your computer configuration to meet the preceding system requirements for the 
successful installation of the software. 
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2. Install and Uninstall 

2.1 Install Kernel for Exchange Server 

Now, when you are well acquainted with the features of Kernel for Exchange Server software you 
can install the software. Before installing the software please ensure that your computer system 
meets the system requirements.  

Furthermore, check whether the software installer file is available on your computer. If the software 
installer file is not available on your system, download it. One can easily download the installer file 
of Kernel for Exchange software from http://www.nucleustechnologies.com/download-exchange-
server-recovery.php  

After you have downloaded the installer file, execute following steps to install the software: 

1. Double-click the Kernel for Exchange installer file. 

2. Follow the on-screen instructions. The ñCompleting the Kernel for Exchange Server 
Setup Wizardò message appears on the software installation screen when the installation 
process completes. 

3. Click the Finish button to complete the software installation process and launch Kernel for 
Exchange Server software.  

2.2 Uninstall Kernel for Exchange Server 

There can be a situation when you need to uninstall Kernel for Exchange Server software from 
your computer system. The software can be uninstalled from your computer in the following two 
ways: 

¶ Uninstall through Windows Start Menu 

¶ Uninstall through Control Panel 

@ Before you start uninstalling Kernel for Exchange Server makes you sure that 
the software is not running in system background. 

2.2.1 Uninstall through  Windows Start Menu  

Perform the following steps to uninstall Kernel for Exchange Server through Windows Start menu: 

1. Click Start > All Programs > Kernel for Exchange Server > Uninstall Kernel for 
Exchange Server. A warning message will be displayed to let you confirm the un-
installation process. 

http://www.nucleustechnologies.com/download-exchange-server-recovery.php
http://www.nucleustechnologies.com/download-exchange-server-recovery.php
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2. Click the Yes button to continue the un-installation process. The ñKernel for Exchange 
Server was successfully removed from your computerò message appears. 

3. Click the OK button to complete the un-installation process.  

2.2.2 Uninstall through  Control Panel  

Execute the following steps to uninstall Kernel for Exchange Server through Control Panel: 

1. Click Start > Control Panel. 

2. Double-click Add or Remove Programs icon.  

3. Select Kernel for Exchange Server ver 9.09.01 and click the Remove button. A warning 
message will be displayed. 

4. Click the Yes button to continue the software un-installation process. The ñKernel for 
Exchange Server was successfully removed from your computerò message appears. 

5. Click the OK button to complete the un-installation process.  
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3. Understanding the User Interface 

3.1 Menu Bar 

Menu bar of Kernel for Exchange Server comprises the following main menus: 

¶ File Menu 

¶ View Menu 

¶ Options Menu 

¶ Help Menu 

 

File Menu 

File menu of Kernel for Exchange Server is shown in Figure 3.1: 

 

Figure 3.1: File menu 

Table 3.1 lists the options of File menu: 

Option Description 

Repair Opens the Select Source dialog box to let you select the 
corrupt Exchange database file. 

Save Saves the selected recovered mailboxes at a user-defined 
location. 

Exit Closes Kernel for Exchange Server software 

View Menu 

View menu of Kernel for Exchange Server is shown in Figure 3.2: 
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Figure 3.2: View menu 

The View menu has only one option that is Status Bar. When you click this option, a status bar 
appears at the bottom of the software interface. 

Options Menu 

Options menu of Kernel for Exchange Server is shown in Figure 3.3: 

 

Figure 3.3: Options menu 

The Options menu contains the Settings option, which helps you to configure software settings for 
more advanced mailbox recovery. On clicking the Settings option, the Settings dialog box 
appears where you can configure software settings for available recovery modes. Get more 
information about Settings.. 

Help Menu 

Help menu of Kernel for Exchange Server is shown in Figure 3.4: 

 

Figure 3.4: Help menu 

Table 3.2 lists the options of Help menu: 

Option Description 

About Kernel for Exchange 
Server 

Displays the software version and support related 
information 

Software Help Displays the Userôs help manual of Kernel for Exchange 
Server 

3.2 Tool Bar 

Tool bar consists of buttons that work as shortcuts for various options available in the main menus 
of Kernel for Exchange Server software.  

Table 3.3 lists the buttons available on the Tool bar of Kernel for Exchange Server software: 

Button Button Name Description 
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Repair Opens the Select Source dialog box to let 
you select the corrupt Exchange database 
file 

 

Save Saves the selected recovered mailboxes at a 
user-defined location 

 

Help Displays the Userôs help manual of Kernel 
for Exchange Server Software 

3.3 Left Panel 

Left panel of Kernel for Exchange Server displays mailboxes and email folders recovered from the 
damaged Exchange Server database file. The software displays the recovered mailboxes and 
email folders in a tree like structure, so that you can easily navigate through them and view their 
content. Figure 3.5 shows the left panel of Kernel for Exchange Server: 
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Figure 3.5: Left Panel 

3.4 Right Panel 

Right panel of Kernel for Exchange Server is broadly divided into two parts: upper part is the List 
area while the lower part is Preview area. In List area, the software displays the items contained in 
a mailbox or folder, which has been selected from the Left panel while in Preview area you can 
preview the content of a selected email item. In List area, you can also activate the software 
Calendar view for a better view of calendar items. Figure 3.6 displays the Right panel of Kernel for 
Exchange Server: 

 

Figure 3.6: Right Panel 

3.5 Buttons Used 

There are various buttons used in Kernel for Exchange Server software to let you easily and 
quickly perform Exchange database repair and recovery related tasks. Table 3.4 lists the buttons 
used in Kernel for Exchange Server software: 
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Button Button Name Description 

 
Save to HTML file Saves the items of selected folder in tabular 

format in a HTML file. 

 
Stop current process Stops the current process. 

 
Show/Hide Calendar 
view 

Activates or deactivates the Calendar view. If 
the Calendar view is already activated then 
on clicking this button the Calendar view 
becomes deactivated and span of the 
Display area will increase. But, if Calendar 
view is not active then on clicking this button 
Calendar view gets activated.  

 
Show one day Displays the calendar items for a single day.  

 
Show working days Displays the calendar items for five days. 

 
Show week days Displays the calendar items for seven days. 

 
Show month days Displays the calendar items for entire month. 

 
Browse Opens the Open dialog box to let you brwse 

and select appropriate file from your 
computer system. 

 
Search Searches the drives or defined location to 

find the available Exchange database files. 

 
Next Takes you a step forward during the 

Exchange database repair and recovery 
process. 

 
Back Takes you a step back during the Exchange 

database repair and recovery process. 

 
Cancel Cancels the current process. 

 
Finish Ends the current process. 
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4. Using Kernel for Exchange Server 

4.1 Exploring Recovery Modes 

Kernel for Exchange Server repair and recovery software is embedded with three different 
recovery modes. You can select any of these recovery modes to repair or rebuild the damaged 
database depending on the corruption condition and intensity. Kernel for Exchange Server is 
equipped with following recovery modes: 

¶ Automatic Analyze and Recover Mode: This is the fastest mode and is recommended to 
be used when there is less corruption in Exchange database file. Mailboxes recovered 
using this mode are saved in .PST format at the defined location from where you can 
directly access them using MS Outlook.  

¶ Advance Scan Mode: This mode is slower in comparison to Automatic analyze and 
recover mode. You should use this mode when the Exchange database file is highly corrupt 
or the results of Automatic analyze and recover mode are less satisfactory. Mailboxes 
recovered using this mode can be directly accessed with MS Outlook as this mode saves 
the recovered mailboxes in .PST format.  

¶ Rebuild Corrupted Database Mode: This mode helps you to achieve the clean shutdown 
and consistent database state after the database has been damaged due to Dirty shut 
down. In that situation, you need to rebuild the damaged Exchange database and mount 
the new database on Exchange Server.  

This mode of Kernel for Exchange Server software facilitates you to rebuild the Exchange 
database file from damaged database file. The new database file is saved at the user-
defined location in a folder, which is automatically named in the format- Day_Date_Time. 
The format Day_Date_Time refers to current day, date, and time. In the same folder where 
rebuild Exchange database file is saved, a batch file, Verify.bat is also created.  

The Verify.bat file helps you verify the healthiness of the new database file. On double-
clicking the Verify.bat file a .txt file will be generated in which output of the Verify.bat file is 
saved. You can find the .txt file in the same folder where Verify.bat file is available. In .txt 
file internal structure of the new Exchange database file is saved that represents the 
database healthiness. But, if there is some problem in database repairing then instead of 
the database structure, an error message representing the problem in database repairing 
will be saved in .txt file. In case, you see an error message in .txt file then find out the 
reason for that error message, resolve it, and then again try to rebuild the database. After 
that, you can mount the new database file on Exchange Server.  

 

4.2 Configure Software Settings 

Kernel for Exchange Server software provides you various setting options for more accurate and 
fast Exchange database repair and recovery. During the Automatic analyze and repair mode, the 
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software skips the badly corrupted pages of Exchange database file for fast database recovery. 
Due to skipping of severely damaged database pages, output can be affected so, if you want to 
include those pages in Automatic analyze and repair mode without bothering about the time 
consumption then you can configure the related software setting. Apart from this, you can 
configure several other settings that are listed in Table 3.5: 

Setting Description 

Ask for EDB database version Prompts the ñSelect EDB File Versionò dialog box after you have 
selected an appropriate recovery mode during the database 
scanning process. Sometimes, the software may not 
automatically identify the version of damaged Exchange 
database file. At that time, the ñSelect EDB File Versionò dialog 
box appears to let you select the correct file version, if you have 
enabled the ñAsk for EDB database versionò setting option.  

In case, you select the wrong file version the software neither 
displays any error message nor repairs the selected Exchange 
database file. 

Show all types of items in 
folder 

Displays all types of mailbox items in a mailbox preview along 
with the default email items like Notes, Appointments, Events, 
Alarms etc. 

Consider all pages of database 
as badly corrupted 

Includes all badly damaged database pages in scanning 
process. You are suggested to configure this option if you want 
to include database pages as severely corrupt in the scanning 
process for better results.  

Get óFromô field from message 
table 

Helps software to search ñFromò field from alternate location in 
Exchange database. You should select this option when the 
software does not display ñFromò field or show junk characters in 
place of ñFromò field.  

Show all messages in folder 
without checking the content 
existence 

Includes emails that do not have content, in the list of recovered 
email messages. On configuring this option, you can also view 
the emails that only carry information about their senders and 
receivers. (this is applicable for Advance Scan mode only) 

Let us now follow the steps given below to configure various software settings: 

1. Click Start > All Programs > Kernel for Exchange Server > Kernel for Exchange Server to 
launch the software. The Kernel for Exchange Server software starts. When you start the 
Kernel for Exchange Server software, the Select Source dialog box also appears using which 
you select the location of damaged Exchange database file. 
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Figure 3.7: Software Startup Window 

2. Click the Cancel button to close the Select Source dialog box. 

3. Select the Settings option from Options menu. The Settings dialog box appears, as shown in 
Figure 3.8: 
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Figure 3.8: Settings dialog box 

4. Select the relevant checkbox of the setting option you want to configure and click the OK button. 
In this way, you can configure various software settings. If you have selected the ñAsk for EDB 
database versionò option then you a dialogue box ñSelect EDB File Versionò will appear 
during recovery process after selecting the recovery mode: 

 

Figure 3.9: Select EDB File Version dialog box 

In case, you have configured the ñShow all messages in folder without checking the 
content existenceò option in the ñAdvance scan mode settingò section then you can also 
view the emails without content, as shown in Figure 3.10: 
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Figure 3.10: Email without Content 

4.3 Repair Database Using Automatic Analyze and Recover Mode 

Automatic Analyze and recover mode performs fast recovery. With Automatic analyze and recover 
mode, you can even repair large Exchange database file in just few minutes with full accuracy. 
Following steps help you to recover mailboxes from the damaged Exchange database file using 
Advance analyze and recover mode: 

1. Start the Kernel for Exchange Server software either by double-clicking the software icon on 
your computerôs desktop or from Start > All Programs menu. 

2. Click the Browse button on the Select Source dialog box to locate the damaged Exchange 
database file. The Open dialog box appears where you can select the damaged database file, 
as shown in Figure 3.11: 
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Figure 3.11: Selecting Damaged .EDB File  

3. Click the Open button. The path of the selected database file appears in the Select .edb file 
field in the Select Source dialog box, as shown in Figure 3.12: 
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Figure 3.12: Select EDB File for Repairing 

In Select Source dialog box, you have to specify location for edb and stm files along with the 
location of Temp folder: 

¶ *Select .edb file: This field lets you specify the exact location of the damaged .edb file. You 
can also type the location of the damaged .edb file in this field but if you specify the wrong 
location then the software will not perform database repair and recovery.  

¶ Select .stm file: This field lets you specify the exact location of the damaged .stm file. By 
default the Kernel for Exchange Software searches for .stm file in the folder where .edb file 
is present. If the software finds .stm file in that folder then file path gets automatically 
specified in the Select .stm file field. In case, .stm file is located at any other location then 
you can select the file location by clicking the Browse button.  

¶ *Select temp path: This field lets you specify the location of Temp folder. You must 
provide this location because during the recovery process, software generates many 
temporary files that are by default stored in Temp folder. By default the Kernel for Exchange 
Server software consider the following location for Temp folder: 

For Windows XP and earlier versions, path for Temp folder is: 

C:\DOCUME~1\user computer name\LOCALS~1\Temp\ 

For Windows Vista and Windows 7, path for Temp folder is: 
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C:\Users\(User Name)\AppData\Local\Temp 

You can change this default location by clicking the Browse button.  

@ Note: The fields with * symbol are mandatory. 

In case, you are not sure about the location of damaged .edb files then you can take help of 
software search feature. Kernel for Exchange Server software is embedded with the search 
feature, so that you can search for.edb files in a specific hard disk partition or folder.  

4. To search all .edb or .stm files, click the Search button in Select Source dialog box. The 
Search EDB File dialog box appears, as shown in Figure 3.13: 

 

Figure 3.13: Search EDB File dialog box 

5. Click the Browse button. The Browse for Folder dialog box appears to let you select a hard 
disk partition or folder to search for .EDB files: 
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Figure 3.14: Browse for Folder dialog box 

6. Now, select the location where you want the software to search for .edb files and click the OK 
button. The selected location gets automatically specified in the Search EDB File dialog box: 

 

Figure 3.15: Search EDB File 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e dc o v e r y . C o m  P r i v a t e  

L i m i t e d  

 

7. Now, click the Search button. The software starts searching the .edb files at the specified 
location. After the software completes the search process, it lists the all .edb files, as shown in 
Figure 3.16: 

 

Figure 3.16: List of found EDB File(s) 

8. Select the .edb file and click the OK button. The location of the selected .edb file will be 
automatically specified in the *Select .edb file field in the Select Source dialog box.  

9. Click the Next button in the Select Source dialog box to proceed further towards recovering 
mailboxes from the selected .edb file. The Select Recovery Mode dialog box appears in which 
Automatic analyze and recover (Recommended) mode is by default selected: 
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Figure 3.17: Select Recovery Mode 

10. Click the Finish button. The Select EDB File Version dialog box appears to let you select the 
correct version of the selected .EDB file: 

 

Figure 3.18: Select EDB File Version dialog box 

@ Note: The Select EDB File Version dialog box appears only when you have 
configured the ñAsk for EDB database versionò setting in the Settings 

dialog box. 

11. After you have selected the file version, click the OK button to move ahead.  

@ Note: If you select the wrong file version then the software will not recover 

any mailbox from the damaged EDB file.  
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12. The software starts recovering mailboxes from the selected .edb file. While the software 
recovers mailboxes, the Please wait while the current process finishes dialog box appears 
showing the process of mailbox recovery: 

 

Figure 3.19: Please Wait While Current Process Finishes dialog box 

After the software completes the recovery process, the Please wait while current process 
finishes dialog box disappears. Now, you can see the recovered mailboxes in the Left panel 
of the software interface: 
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Figure 3.20: Recovered Mailboxes in Left Panel 

Kernel for Exchange Server not only displays the recovered mailboxes but also show the 
folders of recovered mailboxes.  

13. Expand the desired mailbox to view all folders contained in it. When you expand the mailbox, 
the software displays the folders of the respective mailbox in a tree like structure: 
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Figure 3.21: Expanded Folders of the Selected Mailbox 

The Kernel for Exchange Server software also helps you to view items of any specific folder. 
Moreover, you can also preview the content of a selected email to confirm the recovery 
accuracy before saving the recovered emails.  

14. In case, you want to verify the quality of emails then select the Inbox folder from the Left panel. 
The software lists all the emails in the Right panel. Now, if you want to preview the content of 
an email then select the email and the software previews the selected email, as shown in 
Figure 3.22: 
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Figure 3.22: Preview of the Selected Email after Recovery 

15. Now, you can save the recovered mailboxes at the desired location. By default all the 
recovered mailboxes are saved at the defined location. But, in case, you want to save some 
selected mailboxes then select only those mailboxes that you want to save. Now click the Save 
button in Tool bar.  

The Browse for Folder dialog box appears to let you select the location for saving the 
recovered mailboxes.  

16. Select a location and click the OK button to continue the saving process. As soon as you click 
the OK button, the software starts the saving process, as shown in Figure 3.23: 
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Figure 3.23: Saving Process 

After the software completes the saving process, .PST files for each mailbox will be created at 
the specified location. Now, you can access those .PST files using MS Outlook.  

4.4 Repair Database Using Advance Scan Mode 

Advance Scan mode is slower in comparison to Automatic analyze and recover mode but provides 
more accurate result than it. You are suggested to use this mode when the database file is highly 
corrupted. Furthermore, you can also use this mode when Automatic analyze and recover mode 
does not give you the satisfactory results. Following steps help you recover mailboxes from 
damaged edb file using Advance Scan mode: 

1. When you launch Kernel for Exchange Server it appears with the Select Source dialog box, as 
shown in Figure 3.24: 
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Figure 3.24: Advance Scan Mode: Select Source dialog box  

2. In the Select Source dialog box click the Browse button to locate the damaged .edb file. The 
Open dialog box appears from where you can select the damaged .edb file, as shown in Figure 
3.25: 
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Figure 3.25: Advance Scan Mode: Select Damaged .EDB File  

3. After selecting the .edb file, click the Open button to continue the process of recovering 
mailboxes from the damaged .edb file. The location of the selected .edb file appears in the 
*Select .edb file field.  

4. Click the Next button to move one step ahead in the recovery process. The Select Recovery 
Mode dialog box appears.  

5. Now, click the Advance Scan (This mode is slow) option to perform recovery with Advance 
scan mode, as shown in Figure 3.26: 
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Figure 3.26: Advance Scan Mode: Select Recovery Mode  

6. Click the Finish button. The Select EDB File Version dialog box appears to let you select the 
correct file version, as shown in Figure 3.27: 

 

Figure 3.27: Advance Scan Mode: Select EDB File Version  

7. Click the OK button after selecting the correct file version. The Please wait while current 
process finishes dialog box appears showing the status of the process of mailbox recovery: 


